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CITS500s OPERATOR MANUAL

POLAR INSTRUMENTS LTD.  HARDWARE WARRANTY

1. Product Warranty.  Product hardware is warranted to be free from defects in material and
workmanship during the Warranty Period (as defined below). Product hardware is warranted to
conform substantially to Polar’s then current (as of the date of Polar’s product shipment) published
user documentation during the Warranty Period. The Warranty Period is twelve (12) months. Product
support beyond these periods may be available at additional cost – consult Polar for details.

 
2. Warranty Claims.  Polar shall incur no liability under this warranty if the end user fails to provide

Polar with notice of the alleged defect during the applicable Warranty Period and within seven (7)
days of delivery to end user or, if the defect would not have been reasonably apparent on inspection,
within seven (7) days of its discovery by end user. After receiving such notice, Polar will notify the
purchaser of its designation of one of the following problem resolution methods:

 
Return to Factory: The allegedly defective goods must be returned to Polar within seven days of
Polar’s notice and in accordance with Polar’s instructions advised at the time.

Other:  Polar will use commercially reasonable efforts to repair, correct or work around the problem
by means of telephone support or other means reasonably determined by Polar.

 
 Polar shall incur no liability under this warranty if Polar’s tests disclose that the alleged defect is due to

causes not within Polar’s reasonable control, including alteration or abuse of the goods. Under the
Return to Factory alternative, if a Product is determined not to be defective or to have a defect due to
causes not within Polar’s reasonable control, Polar reserves the right to apply a processing charge.

 
3. Damage in Transit.  End user must notify Polar and the carrier of any claim for damage in transit

within two (2) days of receipt of the damaged merchandise. Failure to do so may result in the carrier
and/or Polar refusing to accept liability in which case end user must pay the purchase price as if the
hardware had been delivered without damage.

 
4. Polar’s Liability Polar’s liability, and end user’s sole and exclusive remedy, shall be limited to the

express remedies set forth in this Polar Hardware Warranty.
 
5. Disclaimer of Warranties.  POLAR MAKES NO OTHER WARRANTIES, EXPRESS, IMPLIED OR

STATUTORY, REGARDING PRODUCTS. ALL OTHER WARRANTIES AS TO THE QUALITY,
CONDITION, MERCHANTABILLITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-
INFRINGEMENT ARE EXPRESSLY DISCLAIMED.

 
6. Limitation of Liability.  POLAR SHALL NOT BE RESPONSIBLE FOR DIRECT DAMAGES IN

EXCESS OF THE PURCHASE PRICE PAID BY THE END USER OR FOR ANY SPECIAL,
CONSEQUENTIAL, INCIDENTAL, OR PUNITIVE DAMAGE, INCLUDING, BUT NOT LIMITED TO,
LOSS OF PROFITS OR DAMAGES TO BUSINESS OR BUSINESS RELATIONS, WHETHER OR
NOT ADVISED IN ADVANCE OF THE POSSIBILITY OF SUCH DAMAGES, THE FOREGOING
LIMITATIONS SHALL APPLY, NOTWITHSTANDING THE FAILURE OF ANY EXCLUSIVE
REMEDIES.

Copyright Polar Instruments Ltd. ©2001

Microsoft, MS-DOS, Windows, Windows 95, Windows 98, Windows NT and Windows 2000 are
registered trademarks of Microsoft Corporation.

IBM is the registered trademark of International Business Machines Corporation.
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DECLARATIONS

EUROPEAN COMMUNITY DIRECTIVE CONFORMANCE STATEMENT
This product conforms to all applicable EC Council Directives, including:
EC Council Directive 89/336/EEC on the approximation of the laws of the
Member States relating to electromagnetic compatibility.
EC Council Directive 73/23/EEC on the harmonisation of the laws of the
Member States relating to electrical equipment designed for use within
certain voltage limits.
A declaration of conformity with the requirements of these Directives has
been signed by:
POLAR INSTRUMENTS (UK) LTD
11 College Place
London Road
Southampton
England
SO1 2FE
Harmonised standards applied in order to verify compliance with these
Directives:
EN 50081-1:1992
EN 50082-1:1992
EN 61010-1:1993
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SAFETY

WARNING

The LIVE and NEUTRAL lines on this unit are BOTH fused.
This unit contains no user-serviceable parts. When the unit is
connected to its supply, the opening of covers or removal of
panels is likely to expose dangerous voltages. To maintain
operator safety, do not operate the unit unless the enclosure is
complete and securely assembled.

GROUNDING

This unit must be earthed (grounded); do not operate the
instrument with the safety earth disconnected. Ensure the
instrument is connected to an outlet with an effective protective
conductor terminal (earth). Do not negate this protective action by
using an extension cord without a protective conductor.
Note: This instrument is fitted with 3-wire grounding type plug
designed to fit only into a grounding type power outlet. If a special
local plug must be fitted to the power cord ensure this operation is
performed by a skilled electronics technician and that the
protective ground connection is maintained. The plug that is cut off
from the power cord must be safely disposed of.
Power cord color codes are as follows:

Europe
brown live
blue neutral
green/yellow earth (ground)

United States
black live
white neutral
green ground
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POWER SUPPLY

Check that the indicated line voltage setting corresponds with the
local mains power supply. See the rear panel for line voltage
settings.
To change the line voltage settings refer the instrument to a skilled
electronics technician. Instructions for changing the line voltage
settings are contained in the CITS Service Manual published by
Polar Instruments.

CITS OPERATION

This manual contains instructions and warnings which must be
observed by the user to ensure safe operation. Operating this
instrument in ways other than detailed in this manual may impair
the protection provided by the instrument and may result in the
instrument becoming unsafe. Retain these instructions for later
use.
The unit is designed for use indoors in an electrical workshop
environment at a stable work station comprising a bench or similar
work surface. Use only the accessories (e.g. test probes and
cables) provided by Polar Instruments. The unit must be
maintained and repaired by a skilled electronics technician in
accordance with the manufacturer’s instructions.
If it is likely that the protection has been impaired the instrument
must be made inoperative, secured against unintended operation
and referred to qualified service personnel. Protection may be
impaired if, for example, the instrument:

•  Shows signs of physical damage

•  Fails to operate normally when the operating
instructions are followed

•  Has been stored for prolonged periods under
unfavourable conditions

•  Has been subjected to excessive transport stresses

•  Has been exposed to rain or water or been subject to
liquid spills
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 CAUTION

 Electrical Isolation
 Always disconnect the board under test from the local mains
supply (including ground) before using this instrument. The CITS
applies test voltages to the item under test. Make sure that the
item under test is isolated from all other sources of electrical
power. External power could damage the tester.

 Static Sensitive Devices
 This unit contains Static Sensitive Devices. Observe static
precautions at all times.
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 SPECIFICATIONS

 Test parameters
 Controlled Impedance Measurement Range  0 – 150Ω

 Measurement Accuracy  1% at 50Ω

 1.25% at 75Ω

 1.5% at 28Ω and 100Ω

 (Calibrated against traceable standards at 28Ω,
50Ω, 75Ω and 100Ω)

 Impedance Tolerance Range  0.1% – 99.99%

 Vertical Display Ranges (Ω)  1, 2, 5, 10, 20, 50Ω/division
 Vertical Display Ranges (mRho)  10, 20, 50, 100, 200, 500 mRho/division
 Horizontal Display Ranges  Automatically set by software
 Testable Trace Lengths
Maximum
Minimum (using non-matched probe)
Minimum (using matched probe)

 
15 meters
0.09 meters
0.04 meters

 Horizontal Distance Units  Inches, feet, meters, millimeters
 Horizontal Time Units  Nanoseconds, picoseconds
 Test Method  Time Domain Reflectometer (TDR

measurement using PC software control)
 Reflected Pulse Risetime  ≤ 200ps
 System Bandwidth  1.75 GHz (derived from maximum risetime)
 Output Impedance  50Ω (± 2%)
 Pulse Amplitude  Nominal 300mV into 50Ω load
 Calibration Method  Ratiometric measurement to calibrated

precision internal 50Ω reference
 Series Loss Compensation  0 – 5Ω/inch
 Vp Compensation  0.33 – 0.99
 Relay Life  2 x 106 operations/channel (typical)
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 ENVIRONMENTAL OPERATING CONDITIONS

 The instrument is designed for indoor use only under the following
environmental conditions:
 

 Altitude  Up to 2000m

 Temperature  +10°C to +30°C ambient

 Relative humidity  RH 80% maximum at 31°C — derate
linearly to 50% at 40°C

 Mains borne transients  As defined by Installation Category II
(Overvoltage Category II) in IEC664

 Pollution Degree  2 (IEC664)

 

 Power Requirements
 230V ± 10%, 115V ± 10% or 100V ± 10% at 50/60Hz, 20VA.

 Physical characteristics (excluding accessories)
 Temperature
Operating 10°C to 30°C
 Storage 0°C to +50°C
 Dimensions
 443 mm (17.44 in.) wide
 114 mm (4.48 in.) high
 280 mm (11.02 in.) deep
 Weight 5.0kg (11 lb.)
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 SYMBOLS

   CAUTION No external voltage should be applied to
these terminals.
 

   CAUTION Static sensitive devices — observe static
precautions. A wrist strap is provided with the CITS (connect the
wrist strap to the socket on the CITS front panel).
 

 Note: The CITS contains static sensitive devices — observe static
precautions at all times.

 PERSONAL COMPUTER REQUIREMENTS

 Computer  IBM PC AT or compatible
 Processor  Pentium 100 or better
 Operating system  Microsoft Windows 95, Windows 98

Microsoft Windows NT/2000
 System memory required  16MB Windows 95, Windows 98

 32 MB Windows NT, Windows 2000
 Hard disk space required  2MB (min.)
 Video standard  SVGA (800 x 600 min.)
 Diskette drive  3½" High density – 1.44Mbyte
 Mouse  Microsoft compatible
 Printer port  1 x parallel printer port
 Communication ports  1 available serial communication port

required
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 ACCESSORIES

 Standard Accessories
 Probe Cable (CITS500s x 2, CITS500s4 x4) WMA326

 IP-50 Microstrip Probe (50Ω)

 IPD-100 Differential Probe (100Ω)
 Sample Test Coupon MPCD1325
 Operator manual MAN174
 RS-232 interface cable ACC142
 Foot Switch ACC124
 Antistatic wristband ACC175
 Wrist band ground cord ACC185
 Manufacturing data files diskette FSW148
 Software diskette FSW163
 Si6000 (Demonstration version) FSW176

 Optional Accessories
 Instrument carrying case ACC125
 Coupon Holder ACC153
 CITS Service Manual MAN143
 Barcode Reader ACC186

 IP-28 Microstrip Probe (28Ω)

 IP-60 Microstrip Probe (60Ω)

 IP-65 Microstrip Probe (65Ω)

 IP-75 Microstrip Probe (75Ω)

 IP-100 Microstrip Probe (100Ω)

 IP-50V Variable-pitch Microstrip Probe (50Ω)
 CITS25 Differential Impedance Calculator (Full version)
 Datalog Report Generator ACC230
 CITS Verification Kit ACC229
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 GUIDE TO THE MANUAL

  This manual describes the operation of the CITS500s
running the 32-bit version of software.   For earlier versions
of software refer to manual MAN167

 INTRODUCTION  An overview of the Polar CITS500s.
A description of the principles of operation and explanation
of basic TDR principles and controlled impedance.
 

 INSTALLATION/SET UP  Connecting the instrument to a power supply, installation of
software and preparation for use.

Specifying the PC communication ports, calibration type
and passwords.
 

 GETTING STARTED  Introduction to basic CITS operation using the supplied
sample Test Coupons.

 OPERATION  Operation of the CITS500s. Information about the different
ways in which the facilities of the CITS500s can be used
and how to test boards.
 

 THE TEST FILE EDITOR  Description of test parameters — creating, writing and
saving test files.
 

 MAINTENANCE  Details of maintenance and cleaning procedures.
 

 APPENDIX A  Notes on Characteristic Impedance.
 

 APPENDIX B  Notes on static sensitive devices and preventing damage to
the CITS.
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OPERATING THE CITS500s

 The CITS software is designed for use within the Microsoft
Windows environment. Familiarity with the Microsoft Windows 95,
Windows 98 or Windows NT/2000 environments is assumed.
 For information on Microsoft Windows operation consult the
Microsoft Windows User Guide.
 CITS500s functions are controlled by selecting the associated
commands from pull-down menus or clicking the “short-cut”
buttons with the mouse.

Selecting commands

 Using the keyboard:
 Activate the CITS menu bar by pressing the Alt key on the
keyboard.
 Press the underlined letter in the menu name to display the menu
command list.
 Press the underlined letter in the command name.

 Using the mouse:
 To display a command list, point to the menu name and click the
left mouse button
 Point to the command name and click the left mouse button
 Selecting a command name which is followed by ellipses (...)
displays a dialog box containing options which qualify the
command.

 Clicking the OK button corresponds to pressing the <CR> or
<Enter> key on the keyboard.

 Clicking the Cancel button corresponds to pressing the <Esc> key
on the keyboard.

 On-line help
 The CITS software incorporates comprehensive on-line operating
information. The Help command offers a rapid and convenient way
to find information, such as how to perform tasks. Press the <F1>
key to access the Help file.
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 SECTION 1 — INTRODUCTION
 

 INTRODUCTION TO CONTROLLED IMPEDANCE
TESTING

 1-1 The CITS system
 The CITS500s Controlled Impedance Test System is designed to
provide low cost automated measurements of the characteristic
impedance of printed circuit boards and test coupons. The CITS
system is shown in the diagram below.

 

 Figure 1-1 The CITS Controlled Impedance Test System
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 The Controlled Impedance Test System comprises a
measurement system controlled by software running within the
Microsoft Windows environment on an IBM PC compatible
computer.
 The CITS500s is designed to facilitate rapid and convenient
testing of controlled impedance printed circuit boards and test
coupons.
 Connection between the CITS and boards under test is achieved
using probe cables and Microstrip probes.
 The CITS software is written to run within the Microsoft Windows
environment,so test result waveforms may be printed out using the
currently installed printer.
 The CITS system may be controlled from the PC keyboard or by
simple point-and-click operations with a Microsoft-compatible
mouse. Use of a mouse is recommended for maximum ease of
use.
 A plug-in foot-switch is included with the CITS to allow the
operator to perform hands-off testing.

 1-2 Test files
 All the information necessary for performing a controlled
impedance measurement on a circuit board is stored in a test file.
An operator only needs to select the appropriate test file from a list
and the system is ready for testing.
 Test files are easily created and modified using the integrated test
file editor — most files will be created with just a few key strokes
and mouse clicks.
 Test files provide a convenient method for automated testing of
boards with a number of different controlled impedance traces.

 1-3 Data analysis
 Test results are displayed as a graph of impedance against
distance along a PCB track and a PASS or FAIL result is reported
according to whether or not the trace remains within tolerance
over the full length of the tested region. The average, standard
deviation, minimum and maximum impedance values over the
tested region are displayed on screen along with the waveform.
Odd and even mode impedances are included in differential tests.
 All test results are displayed on the PC screen in waveform and
statistical form for rapid analysis. Waveforms may also be stored
to disk for later inspection.
 Test data may be logged for subsequent statistical analysis. The
stored data may be printed out or imported into a spreadsheet or
the Datalog Report Generator (Optional Accessory).
 The CITS also generates data in delimited format (suitable for
importing into a spreadsheet or database) for statistical process
control (SPC) analysis.
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 1-4 CITS features
 The CITS system is designed to make the complex process of
impedance testing as simple as possible. The CITS500s includes
the following features:

 User interface
 Microsoft Windows 95, 98 or Windows NT/2000 environment
 Mouse driven user interface for ease of use
 Comprehensive on-line help

 Board testing
 Two channels (CITS500s) or four channels (CITS500s4)
 Wide range of Microstrip probes for easy connection to the

board under test
 Automatic instrument set up
 Integrated test file editing
 Group testing for verification of impedance spread.

 Data logging
 Rapid data logging of test results
 Statistical analysis for process control
 Disk storage of test results
 Hard copy of test & stored results

 Display
 Linear display of impedance against distance (in inches or metric

measurements) or time
 Impedance display in Ohms or mRho
 Differential impedance measurement facility
 On-screen cursors for easy distance measurement
 On-screen display of waveform statistical analysis
 Simple Pass/Fail PCB track test results displayed in waveform

window
 Waveform overlay for rapid comparison of results
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 Status Outputs
 The CITS includes opto-isolated, open-collector Status
Outputs (located on the rear of the CITS) to provide a
hardware indication of the PASS/FAIL results of a test.
See Appendix C for connector details.

 Statistical Process Control
 The CITS provides the facility to log continuously all data
to an external file. The file is in delimited text format so can
be easily imported into and edited by a spreadsheet or
database and includes fields which can be used by
statistical process control systems.

 1-5 Characteristic impedance
 As the speed of electronic devices increases the electrical
properties of the circuits carrying signals between them become
more important.
 At the high frequencies and clock rates of modern digital circuitry,
cables and PCB tracks increasingly need to be considered as
transmission lines.
 In the case of PCB tracks the series resistance and parallel
conductance of the transmission lines are largely negligible. The
most significant circuit parameters governing performance are the
distributed series inductance and parallel capacitance of the
conductors.
 These parameters give rise to the characteristic impedance Zo.

 C
L =oZ

 where L is in henrys per unit length, C is in farads per unit length
and Zo is in ohms.
 Consider an electrical signal travelling through a conductor such
as a PCB track.
 When the signal encounters a change of impedance (Zo) arising
from a change in material or geometry, part of the signal will be
reflected and part transmitted.
 These reflections are likely to cause aberrations on the signal
which may degrade circuit performance.
 To optimise performance of high speed circuits it is desirable to
match the input and output impedances of devices with the
characteristic impedance of the interconnections.
 See Appendix A for a more detailed discussion of characteristic
impedance.
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 1-6 TDR fundamentals
 The CITS500s Controlled Impedance Test System makes
measurements using Time Domain Reflectometry (TDR).

 Time Domain Reflectometry
 A Time Domain Reflectometer is a special kind of oscilloscope.
 A “normal” oscilloscope measures changes in voltage over a
period of time and displays this as a graph. A TDR performs a
similar function but incorporates additional circuitry to output a
voltage and monitor changes in that voltage level over a period of
time.
 Time domain reflectometry is similar in principle to radar or sonar
in that a signal is transmitted and the reflections or echoes of that
signal are monitored. In the case of TDR the signal is a voltage
transmitted along a cable or PCB track.
 Reflections of the signal occur when there is a change in the
characteristic impedance of the conductor. The time taken for the
reflections to return to the TDR can be used to measure the
distance to any change in impedance.

 

 Figure 1-2 Simplified TDR-cable system equivalent circuit
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 The diagram below shows a typical TDR waveform.

 
 

 Figure 1-3 TDR trace showing voltage steps at impedance discontinuities

 As a step wave propagates down a cable any increase in
characteristic impedance causes a reflected voltage which adds to
the initial step.
 This is shown, for example, in the previous diagram by the step up
from the 50Ω to 75Ω cable.
 A decrease in impedance would cause a reflection in the opposite
sense which would show as a downward step in the TDR trace. As
long as the characteristic impedance remains constant the trace
remains level.
 An open circuit at the end of the cable reflects 100% of the voltage
in a large upward step.
 If the end of the cable were to be short circuited a 100% reflection
in the opposite direction would occur, returning the trace to the
zero voltage level.

 1-7 CITS measurements
 The CITS displays a graph of the characteristic impedance of a
specified length of PCB trace.
 This is achieved by calculating the impedance along the length of
the cable or PCB based on the size of the reflections measured
using time domain reflectometry.
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 Single ended impedance testing
 Normal controlled impedance structures comprise a single signal
conductor and a ground plane or planes. Impedance
measurements made between the signal and ground are
sometimes referred to as single-ended.
The single-ended transmission line is probably the commonest
way to connect two devices. In this case a single conductor
connects the source of one device to the load of another device.
The circuit below is an example of a single-ended transmission
line.

The reference (ground) plane provides the signal return path. This
is an example of an unbalanced line. The signal and return lines
differ in geometry — the cross-section of the signal conductor is
different from that of the return ground plane conductor.
The impedance of a PCB trace will be determined by its inductive
and capacitive reactance, resistance and conductance. These will
be a function of the physical dimensions of the trace (e.g. trace
width and thickness) and the dielectric constant of the PCB
substrate material and dielectric thickness. PCB impedances will
typically range from 25 to 120 ohms.

Single-ended transmission lines on PCBs
In practice, a single-ended PCB transmission line typically consists
of a line conductor trace, one or more reference planes and a
dielectric material. Two configurations are commonly used,
microstrip and stripline. The simplest configuration, the surface (or
exposed) microstrip, shown in the diagram below, consists of a
signal line, the top and sides exposed to air, on the surface of a
board of dielectric constant Er and referenced to a power or
ground plane. Surface microstrip can be implemented by etching
one surface of double-sided PCB material.
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The diagram shows the characteristic microstrip impedance
attributes:

the microstrip impedance references a single plane
the impedance trace is often on an outer layer.

The trace and plane(s), form the controlled impedance. The PCB
will frequently be multi-layer in fabrication and the controlled
impedance can be constructed in several ways. However,
whichever method is used the value of the impedance will be
determined by its physical construction and electrical
characteristics of the dielectric material:

The width W, W1 and thickness T of the signal trace
The height H of core or pre-preg material either side of the
trace
The configuration of trace and planes
The dielectric constant Er of the core and pre-preg material

The stripline (shown in profile below) typically consists of a line
conductor trace sandwiched between two reference planes and a
dielectric material.

The transmission line, i.e. the trace and planes, form the
controlled impedance. The value of the impedance will be
determined by its physical construction and electrical
characteristics of the dielectric material:

The width and thickness of the signal trace
The dielectric constant and height of the core or pre-preg
material either side of the trace
The configuration of trace and planes

Electromagnetic waves in a vacuum travel at the speed of light.
The propagation velocity in a material is primarily dependent on
the Er of the material (it’s roughly inversely proportional to the
square root of the dielectric constant of the material). Assuming a
value of about 4 for dielectric constant for G-10 or FR-4 (the actual
value will depend on frequency and the glass to resin ratio) the
propagation velocity will approximate to half the speed of light.
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 Differential impedance testing
 A more complex type of controlled impedance structure is that of a
differential pair of signal conductors. The lines are driven as a pair
with one line transmitting a signal waveform of the opposite
polarity to the other. At the receiving end one signal is subtracted
from the other so noise induced in both lines is cancelled out. This
method is commonly employed to achieve high noise immunity in
high speed digital and analog systems.
 The characteristic impedance of a differential pair is affected not
only by the impedance of each line of the pair to ground but also
by the interaction of the signal lines with each other.
 The CITS500s includes the facility to make differential impedance
measurements in which the impedance between conductors is
tested as well as the impedance between conductors and ground.
The differential configuration (often referred to as a balanced line)
is used when better noise immunity and improved timing are
required. In differential mode the signal and its logical complement
are applied to the load.

The balanced line thus has two signal conductors and an
associated reference plane or planes as in the equivalent single-
ended (unbalanced) case. Fields generated in the balanced line
will tend to cancel each other, so EMI and RFI will be lower than
with the unbalanced line. External noise will be "common-moded
out" as it will be equally sensed by both signal lines.

Differential transmission lines on PCBs
A typical differential configuration, the edge-coupled surface
microstrip is shown below

 
 In this construction the gap S between the traces defines the
coupling factor and hence the differential impedance. The etch
factor, plating density and undercut will make this construction
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simple to manufacture, but with a wider tolerance due to the extra
processing required on external layers.
 The stripline construction is also used in differential pair
configurations. A typical construction, the edge-coupled symmetric
stripline is shown below

 

 The edge-coupled symmetric stripline is the simplest differential
construction possible, though it may prove difficult to maintain the
signal traces exactly in the centred position with any offset from
the centred position reducing the impedance.

The Differential Test
 The Differential Test makes differential impedance measurements
in which the impedance between conductors is tested as well as
the impedance between conductors and ground.
Normal controlled impedance structures comprise a single signal
conductor and a ground plane or reference plane. Impedance
measurements made between the signal and ground are
sometimes referred to as single-ended.
Where higher performance (e.g. greater noise immunity and better
EMC performance) is required a more complex type of controlled
impedance structure is employed — that of a differential pair of
signal conductors. The lines are driven as a pair with one line
transmitting a waveform of opposite polarity to the other.
At the receiving end one signal is subtracted from the other so any
noise induced in both lines is cancelled out. This is a technique
commonly used to increase noise immunity (and reduce signal
skew in bus circuitry) in high speed digital and analog systems.
The characteristic impedance of a differential pair, therefore, is
affected not only by the impedance of each line of the pair to
ground but also by the interaction of the signal lines with each
other.
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 Test coupons
 The impedance of a PCB trace depends on a number of factors,
including the dimensions of the trace (i.e. trace width and
thickness) and the thickness and dielectric constant of the
laminate and pre-preg material. It's common practice for board
manufacturers to check controlled impedance build integrity initially
by building engineering lots to verify copper weight, line widths and
dielectric thickness and constant before beginning volume
production. Even in production manufacturers perform 100%
controlled impedance testing on controlled impedance boards.
 However, it is not uncommon for the actual PCB traces to be
inaccessible for testing. In addition, traces may be too short for
accurate measurement and will probably include branches and
vias which would also make exact impedance measurements
difficult. Adding extra pads and vias for test purposes would
almost certainly adversely affect the performance of a controlled
impedance trace as well as occupying valuable board space. PCB
testing is therefore normally performed, not on the PCB itself, but
on one or two test coupons integrated into the PCB panel. The
coupon will be of the same layer and trace construction as the main
PCB and will include traces with precisely the same impedance as
those on the PCB, so testing the coupon will give a high degree of
confidence that the board impedances will be correct.
 The CITS500s includes two Test Coupons of known single-ended
and differential impedance, typical of those used in manufacturing
which are supplied with the associated test files so that users may
familiarise themselves with the operation of the instrument.
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 SECTION 2 — INSTALLATION AND SET UP

 SETTING UP THE CITS SYSTEM

 System requirements
 The CITS software is designed to run on a personal computer
meeting the following specifications:

 

 Computer  IBM PC AT or compatible
 Processor  Pentium 100 or better
 Operating system  Microsoft Windows 95, 98

 Microsoft Windows NT/2000
 System memory required  Windows 95, 98  16MB
  Windows NT/2000  32MB
 Hard disk space required  2MB
 Video standard  SVGA (800 x 600 minimum)
 Diskette drive  3½" High density 1.44MB
 Mouse  Microsoft compatible
 Printer port  1 x parallel printer port
 Serial Communication ports  1 x available serial communication

port required

 2-1 Unpacking
 The instrument is shipped in a sturdy transit pack. Open the pack
carefully and remove the instrument and its accessories. If the
instrument is damaged in any way contact the local distributor or
supplier.
 Retain the pack for possible future use.
 Note: Always obtain a Return Number before returning an
instrument to Polar Instruments.
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 The package should contain:
 CITS500s/CITS500s4

 50Ω Probe cables (x2)
 IP50 Microstrip probe
 IPD100 Differential Probe
 Sample test coupons
 Power cord
 RS 232 interface cable
 Foot switch
 Accessory pouch
 Operator manual
 Program installation diskette
 Anti-static wrist band and cord

 Note: If the instrument has been shipped or stored in a cold
environment, allow the instrument to reach the temperature of its
new location before applying power.

 2-2 Connecting to a power supply
 Refer to the voltage label on the rear panel of the instrument
and make sure that the marked rating is suitable for the local
mains power supply.
 If the rating on the label is not suitable for the local power supply
refer the instrument to a skilled electronics technician. Instructions
for changing the line voltage settings are contained in the CITS
Service Manual.
 Note: If a special local plug must be fitted to the power cord
ensure this operation is performed by a skilled electronics
technician and that the protective ground connection is
maintained. The plug that is cut off from the power cord must be
safely disposed of.
 Power cord color codes are as follows:
 Europe
 brown live
 blue neutral
 green/yellow earth (ground)
 United States
 black live
 white neutral
 green ground
 Connect the power cord to the instrument and to the power
source.
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 2-3 Installing the CITS software

Installing the program
Close all other programs.
Insert the CITS500s Software CDROM in the drive and

follow the install wizard instructions on screen.
If the install program does not run when the CDROM is

inserted:

Click the Start button — choose Settings.

Choose Control Panel
Double Click the Add/Remove Programs icon.

On the Install/Uninstall tab click the Install button.

When Setup.exe appears in the Command line box click
Finish.

Follow the instructions on screen.

 Choosing the install folder
 The CITS Installation program proposes the destination location
—  the drive and folder of the hard disk onto which the CITS
program is to be installed (by default C:\Program
Files\Polar\Cits500s).

 Press <Continue> to accept the proposed destination drive and
folder or type the name of an alternative drive and folder.
 To choose an existing drive and folder (directory) press the
Choose Directory button — the Choose Directory dialog box is
displayed.
 Navigate to the destination directory from the Choose Directory
box and press OK
 Press <Continue>.
 The Installation program will prompt for a name for the CITS
program group. The CITS program icons will be created in the
specified program group.

 Press <Enter> to accept the proposed name, or type in a different
name in the name box or select an existing group (press the drop-
down list box arrow to display the current group list).
 The installation program will create the CITS directory and file
structure, copy the CITS files onto the hard disk and create a
program group and the CITS program item.

The CITS
program icon

 Hint: The CITS program may be started each time Windows is
started — hold the <Ctrl> key depressed and drag the CITS icon
with the mouse to copy it to the Startup group.
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 2-4 Connecting the computer to the CITS
 CITS commands and data are transferred between the CITS and
the host computer via a serial communication (RS 232) link using
the supplied cable.

 Ensure the host computer and the CITS are both powered
down before connecting cables.

 Connecting the CITS to the communication port
 Connect the cable between the host computer's serial port and the
connector on the rear of the CITS. Ensure the connections are
secure. If a serial mouse is connected to the PC, the mouse will
normally be connected to the host computer's serial port COM1 or
COM2 — connect the CITS serial cable to an available port, using
a 9 to 25-pin adaptor if necessary. (Note: if a 9 to 25-pin adaptor is
used all 9 pins must be wired).

 Connecting the CITS peripherals
 Plug the Foot Switch ¼” jack plug into its socket on the rear of the
CITS. Plug in the 4mm anti-static wrist strap.
 Connect the Barcode Reader (if used) between the keyboard and
the computer — unplug the keyboard from the computer, plug the
Barcode Reader into the keyboard socket on the computer and
plug the keyboard into the Barcode Reader.

Connecting the cables
 The CITS is calibrated before shipment using cables labelled with
the channel number and instrument serial number. If a cable is
replaced the instrument should be re-calibrated and the cable
relabelled with the channel number and the instrument serial
number.
 For single-ended testing connect a probe cable to its
corresponding SMA front panel connector of the CITS and
connect the Microstrip probe to the probe cable.
 For differential testing connect the differential probe (e.g. the
IPD100 probe) to Channels 1 and 2 or Channels 3 and 4 SMA
connectors using the supplied cables.
 Power up the CITS and the host computer. The green BUSY LED
should light for approximately 5 seconds and then turn off,
indicating that the system is operating normally.
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 2-5 Running the program
 

The CITS
program icon

 To start the program, double click the CITS icon with the mouse
or highlight the icon and press <Enter>.

 After a few seconds the main CITS display will appear.
 Note: If the program is being run for the first time, the system
Configuration dialog box is displayed.
 Options can be changed at any time during normal operation by
choosing Config from the Utilities menu.

 The CITS installation
program will select COM2
by default (the mouse on
most systems is connected
to COM1). Choose the port
appropriate to your system.

 The Config dialog box allow the user to specify the host
computer’s Serial Communications Port to be used when
transferring commands and data – select the appropriate port and
press OK to confirm.
 

 2-6 System configuration
 The system configuration (Config) dialog allows the operator to
specify the CITS operating environment.

 From the Options menu select Config... to display the Config
dialog box. Select the General tab:

 To exit any of the System Configuration menus without
recording any changes press <Esc> or click the Cancel button.

 
 

 Figure 2-2 The System Configuration menu
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 General options

 Specifying a user name
 The User field is provided to allow users to add identifying
information such as their company name to printouts.

 To modify the name, use the <Tab> key to activate the User field,
delete the existing name (if any) and enter the new name. The
name will be included in subsequent hard copies of test results.

 Metric Defaults
 The CITS is able to generate distances in English or metric
measurement units. When this box is checked the Defaults button
in the Test Setup Editor is made to generate distances in metric
units.

 Demonstration Mode
 Demonstration mode is provided to allow the CITS program to
be operated without an instrument connected. In this mode when
the Test function is selected the CITS allows the operator to select
a stored waveform for display.

 Specifying the serial communications port
 Commands and data are transferred over the RS232 serial
communications link via one of the host computer's serial
communications ports.

Choosing a communication port
 The Com Port field allows the serial communications port through
which the PC communicates with the CITS to be specified or
changed.
 Typically, if a serial mouse is in use, it will be connected to serial
communications port COM 1. The CITS must therefore be
connected to a different port (usually COM2).
 The system displays the current communication port; specify a
new communication port if necessary — the system will enable the
selected port.
 Other serial communication parameters are set automatically by
the CITS system.
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 Calibration
 To ensure continued accuracy and consistency of measurements
the CITS500s incorporates internal references for self-calibration
purposes.

 The System option allows the operator to control when the CITS
performs a self-calibration.

 Two modes of Calibration are available:

 Autocal
 In Autocal mode the CITS self-calibrates automatically at a given
interval in time. This may be specified from 1 to 60 minutes (the
default is 20 minutes). This is the normal mode of operation.

 Cal On Test
 In Cal on Test mode the CITS self-calibrates before every test.

 System security
 The system Security menu enables the operator to specify
password protection for critical system and test file information.

 Specifying a password
 Specifying a password is optional; if a password is specified,
unauthorised users will be prevented from modifying the system
configuration, editing test files (files containing test parameters) or
deleting logged records. If a password is set it will be requested
before these operations are permitted.

 To specify a password, activate the Password box and type the
password — up to 8 characters may be used. For security,
characters typed will be displayed as asterisks. If no password is
required leave the field blank.

 Confirmation
 If a password is entered the CITS displays a confirmation box. Re-
type the password in the confirmation box to verify the original.

 Activate on Exit
 If a password has been specified, exiting this screen with this box
checked enables password protection immediately; otherwise the
password protection is not enabled until the software is next run.
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 Setting the Testfiles options
Click the Testfiles tab to specify the location for test parameter
files.

 

Test files are stored by default in the C:\Program
Files\Polar\RITS500s folder; to choose another folder click the
Custom option button and navigate to the desired folder.

 Setting the Datalog options
 The Datalog dialog allows the operator to specify datalogging
options. The user can

•  Specify an identifying name for the test station.

•  Choose between date formats.

•  Specify user fields to provide additional board
information (e.g. batch ID, process, etc.). The user
fields can be completed during the datalog process.

•  Change the destination folder for logged data.

 

 Figure 2-3 The Datalog dialog tab
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 Specifying a Station ID
 Click into the Station ID field and type the name of the test

station. This is used when multiple CITS stations are
datalogging to a common log file

 Defining additional user fields
 Extra fields may be added to the datalog to include

additional information such as batch ID, process
information, etc.

 Click into each user field check box to activate the field,
then type the name of the field into the associated text
box.

 Specifying the date format
 The CITS datalogging can record the date in one of two

formats. Choose DD/MM/YY or MM/DD/YY to specify
English or U.S. format.

 Specifying the Datalog folder
 Datalog files are located by default in the C:\Program

Files\Polar\Cits500s\Testfiles folder (assuming a
default installation). To specify a different folder click
the Custom option button.

 

Figure 2-4 Select Datalog folder dialog box

 Navigate to the data logging folder and press Open.
 Note: if necessary, create the folder by right clicking a blank area
within the Select Datalog Target Directory… dialog box and
choosing New then Folder from the shortcut menus.
 See the Windows User Guide for details.
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 Changing the system prompts
 The CITS incorporates facilities automatically to display
confirmation or information dialog boxes as test files are created,
loaded or deleted. Click on the Prompts tab to specify the system
prompt options:

•  Show the Board Notes (a text box containing notes,
instructions, etc. for a board under test) as a test file is
loaded

•  Display a Confirm Delete message to prevent accidental
deletion of a test file

•  Automatically display the Board Details dialog box each
time a new test file is generated

•  Sound an audible warning when a board passes or fails
the test process.

 

 Click the associated check box to select each option.

 Changing the CITS display colors
 Click the Colors tab to change the colors of objects (waveforms,
cursors, graticules, axes, etc.) in the display window. Click on the
object name then click the Edit button to display the color palette.
 If necessary click Define Custom Colors to choose from a wider
range of available colors (the actual range will depend on the
graphics card installed on the machine).

 Click Reset to set colors to their default values.
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 SECTION 3 — GETTING STARTED

 FIRST TIME CITS OPERATION

 IMPORTANT The CITS is an extremely sensitive measuring instrument. To
prevent damage to the CITS, observe static precautions at all times. See
Appendix B for information

 

 This section discusses the basic operation of the CITS program
using the sample test coupons included with the CITS.
 First time operators are encouraged to work through this section
using the coupons and test files provided to verify the correct
operation of the CITS and quickly gain familiarity with the
impedance testing procedure. This section assumes that the
installation/setup procedure has been successfully completed.

 Power up the CITS500s and PC, and press the Start button and
choose Programs, then Cits500s and click the Cits500s program
(or double-click the CITS icon on the desktop) to start the CITS
program. The CITS main screen is shown in Figure 3-1.

 

 Figure 3-1 The CITS main screen
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 Note: the colours of the screen displays may be changed at the
option of the user — the screen views used in this manual may
differ slightly from the system in use.

 The CITS screen
 The CITS screen window is split into three window panes and
comprises six sections:

 The Test List window pane which lists the tests within the
active test file.

 The Waveform Display window pane which displays the
impedance waveform and test results.

 The Datalog Results window pane which displays logged
test results (e.g. for a batch of boards using the active
test file).

 The menu bar containing the CITS commands
 The tool bar which provides short cut access to the most

commonly uses commands.
 The status bar which displays descriptions of the tool bar

buttons as the mouse is moved over each button and
test and datalogging information.

 The CITS window may be increased or decreased in size by
dragging the window borders with the mouse.
 If necessary press the Maximise button to increase the display
size to full screen.

 The CITS main tool bar
 The CITS main toolbar (described in detail in the next section)
contains buttons that provide quick mouse access to the most
frequently used CITS commands:

 

 (In this section we use only the File Open and Execute Test
buttons.)

 The File Open button display the Open dialog box and
allows the user to choose a test file. Each test file contains one or
more tests for the board under test.
 

 The Execute Test button performs a test using the
selected test list item.
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 3-1 Testing the sample coupons
 When testing wear a wrist strap connected to a suitable earth
point. A wrist strap is provided with the CITS (connect the wrist
strap to the stud on the CITS front panel).
 The CITS500s includes sample coupons to allow users to
familiarise themselves with the operation of the instrument. The
single-ended coupon includes three PCB traces of nominal
impedance, 50Ω, 75Ω and 100Ω.
 The actual values measured at the factory are recorded on the
test coupon. The CITS software includes a test file incorporating
the 50Ω, 75Ω and 100Ω tests associated with the coupon.
 Note: the coupons should not be used for calibration purposes.

 The differential coupon includes a single-ended 50Ω trace and
100Ω differential pair.
 To test any PCB trace it is necessary to select the correct test file
for the board trace under test. This file includes the nominal trace
impedance to be tested for, the test tolerance and the distance
over which to test.
 In this section we will test the sample coupons supplied with the
CITS500s.

 Selecting a test file

 The file Open...
button

 From the File menu select Open... or press the Open... button on
the tool bar with the mouse — the Open dialog box appears with
the test files listed. See Figure 3-2.
 

 

 Figure 3-2 The Open Test File dialog

 The Coupon Test file contains the tests associated with the single-
ended coupon. In this example we test the coupon’s 50Ω trace
using the 50 Ohm Test in the Coupon Test file.
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 Select the Coupon Test file by either clicking the mouse on its
name in the file list window or stepping the selection down to it
with the cursor direction keys. Click on OK to select the file.
 The CITS loads the selected test file and displays the list of trace
tests for the coupon in the Test List window pane.
 The CITS provides the option of selecting test files from the list
using the mouse or keyboard arrow keys or using the CITS foot
pedal to advance through the list and perform each test in the
sequence without the use of mouse or keyboard. If a barcode
reader is used this is entered at the start of a cycle.
 Click on the 50 Ohm Test — the Waveform Display pane reflects
the impedance and distance scales for the test and a cross
hatched area indicating the region over which impedance will be
tested. The impedance scale indicates the nominal impedance
and acceptable impedance range.
 Click on the 75 Ohm and 100 Ohm tests and note the changes in
the Waveform display window.
 For the test shown in Figure 3-3 the nominal impedance has been
specified in the test file as 50Ω ±10% so the acceptable range of
impedance values is from 45 – 55Ω. The test is performed over a
6” length of coupon trace (from 2” to 8”).
 

 

 Figure 3-3 The CITS Test Window with the Coupon Test file loaded (50 Ohm test selected)
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 Testing the single-ended coupon
 Note: When executing the test ensure the Microstrip probe signal
pin is connected to the signal pad and the probe ground pin to
coupon ground pad. Typically, ground connections have square
pads to distinguish them from signal pads.
 Note: it is important to use high quality test connections (e.g.
microstrip probes) to minimise aberrations.

 Choose the Datalog menu and ensure the Autolog command is
off (un-ticked).

 The CITS Test
button

 To test the coupon, connect the microstrip probe across the 50Ω
test impedance and press the foot switch or click the Test button.
Take care not to touch the track on the coupon during testing.
 The system will take a few seconds to set up the instrument for
testing and will graph the impedance of the 50Ω trace.
 The CITS displays the trace's impedance against the test program
limits. See Figure 3-4.
 

 

 Figure 3-4 Graph of 50Ω impedance within limits

 If the waveform in remained between the crosshatched area over
the whole of the tested region the CITS records a PASS.
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Displaying the impedance statistics
 The CITS displays the PASS/FAIL result for the test and displays
the impedance statistics over the tested area:

•  average impedance

•  standard deviation

•  minimum impedance

•  maximum impedance
 The tested area is usually the flattest portion of the coupon
waveform and is usually referred to as the undisturbed interval
(ignore test connection aberrations and open circuit termination
effects). Values are presented in the associated boxes on screen
along with the impedance waveform. If the displayed waveform
extends into the crosshatched area the CITS records a FAIL.

 

 Figure 3-5 Graph of 50Ω impedance outside 10% limits

 (If the CITS records a FAIL on the coupon check for correct
probe/coupon polarity and good contact between the microstrip
probe and the trace on the coupon and try again.)

 Repeat the procedure for the 75Ω and 100Ω nominal impedance
traces on the sample coupon using the 75 Ohm Test and 100
Ohm Test respectively.
 As each test is completed a tick or cross is displayed alongside
each test in the Test List window pane to indicate a PASS or FAIL
result for the trace along with the Average value of impedance for
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each test. Test results for all test performed on the coupon are
recorded in the Datalog window pane. A small yellow circle
alongside each result indicates that the logged results have not
been saved to disk.
 The Status Bar indicates which test is currently displayed and the
time to the next automatic calibration.
The CITS foot switch can be used to advance through the list and
perform each test in the sequence without the use of the mouse or
keyboard. Test results (PASS/FAIL) are displayed next to each
test file as testing progresses. When all three test are complete
step through and review each test result (waveform and statistical
results) by clicking the test name in the Test List window pane.

 

 Fig 3-6 Completed set of Single-ended Coupon Test results

 Using the measurement cursors
 The CITS500s incorporates on-screen measurement cursors to
display absolute values of propagation delay times, distance and
impedance along the displayed waveform. Use the cursors for
critical time measurements — click onto each cursor and drag it
with the mouse to the point of interest on the waveform. Each
cursor displays the distance along the trace and impedance at the
point where the cursor crosses the waveform.
 The distance between the cursors, i.e. propagation delay time,
delta time and distance between the cursors are displayed above
the Waveform Display window pane. Delta time (or real time) is
the “out and back” time of the TDR signal. Propagation time, the
“out only” time is calculated as half that value.
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Testing the Differential coupon

The Differential Coupon includes a 100Ω differential pair. Press
the Open button and open the Differential Coupon Test file.
Connect the IPD100 Differential Probe to the Channels 1 and 2 or
Channels 3 and 4 SMA connectors on the CITS front panel.
Select the Differential 100 Ohm Test. Locate the IPD100 Probe
across the 100Ω impedance and press the Test button.

Figure 3-7 Differential Coupon Test PASS result

The differential pair returns results as for the single-ended case
but includes values for Odd and Even mode impedance.
Odd mode impedance is defined as the impedance of either of the
conductors in a differential pair when both drives are driven
differentially (i.e. with signals of equal and opposite polarity), so
odd mode impedance is equal to half the value for differential
impedance in a balanced system.
Even mode impedance is the impedance of either of the
conductors in a differential pair when both drives are driven in
common mode (i.e. with identical signals of the same polarity).

 3-2 Exiting the program
 Select Exit from the File menu or press Alt+F4 to leave the
program and return to the Windows Program Manager.
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 SECTION 4 — SYSTEM OPERATION

 USING THE CITS

 IMPORTANT The CITS is an extremely sensitive measuring instrument. To
prevent damage to the CITS observe static precautions at all times. See
Appendix B for information

 STARTING THE CITS
 Double clicking the CITS icon starts the CITS program. When the
CITS program runs, the main CITS screen is displayed loaded
with the last test file used. Figure 4-1 shows the CITS main
screen:

 

 Figure 4-1  The CITS main screen
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 4-1 The CITS screen
 The CITS500s window is split into three main areas:

 The Test List window pane containing each named tests
within the currently selected test file.
 The Waveform Display window pane which displays the
impedance waveform and statistical results for the selected
test.
 The Datalog Results window pane which displays the
logged results for one or more boards using the current
test file.

 The CITS500s includes two control sections:
 The menu bar containing the CITS commands
 The tool bar which provides short cut access to the most
commonly uses commands.

 The status bar displays descriptions of the tool bar buttons as the
mouse is moved over each button and test and datalogging and
calibration information.
 The CITS window may be increased or decreased in size by
dragging the window borders with the mouse.
 The main screen window can be maximised to full screen view if
desired — click the Maximise button (or double-click the
CITS500s Title Bar or press Alt+Spacebar then X on the
keyboard).

 4-2 The CITS menu bar
 All CITS commands are available from pull-down menus;
commands can be accessed via the keyboard or mouse (see
GUIDE TO THE MANUAL — pviii).

 The File menu
 The File menu provides the commands for working with test files
— the user is able to:

 Create new test files
 Open and save existing files
 Preview and print the displayed waveform, datalog results

or test file list
 Exit from the CITS500s program

 When the File menu appears the last five test files opened are
listed in reverse order.

 The Board menu
 The Board menu contains the commands to insert new tests and
modify existing board test parameters within the current test file.
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Typically each board will have an associated test file containing all
the tests for the controlled impedance traces on the board. Each
board test file will include board setup information (e.g. customer
name, board type and part number) along with notes for the board
(comments, special instructions, etc.)
 Board notes will be displayed at test time.

 The Datalog menu
 The Datalog menu allows the user to control the CITS500s
datalogging facilities. Datalogging enables test data to be
automatically logged to a text file for archiving and subsequent
analysis. The log file can be printed out or imported into a
spreadsheet for analysis or the optional Datalog Report
Generator.

 Automatic data logging can be toggled on or off via the Autolog
command. Autolog is ON by default and its status is saved
between sessions.
 Tests may be cycled through in sequence automatically or
manually selected. If Auto Advance is selected the CITS steps
through the test list from the top depending on the Auto Advance
option specified (Off, On Pass, After Test).
 The Datalog Report Generator command starts the optional
Datalog Report Generator.

 The Waveform menu
 The Waveform menu allows the operator to:

 Save the current waveform as the reference waveform for
a test file — this reference waveform is then displayed in
green (default color) whenever the test file is selected. The
reference waveform is retained even when the screen is
cleared.

Reference waveforms will be removed from the test file
when the associated test parameters are changed.
 Overlay Multiple Waveforms — allowing comparison of a
sequence of test results.
 Record (save) the current waveform to disk for later
viewing.
 View recorded waveforms.

 The View menu
 The View menu allows the user to control the display of CITS500s
screen items (readout, cursors, graticule, toolbar, etc.)
 This menu also allows the user to select for display statistical
information in the Test List and Datalog window panes.
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 The Utilities menu
 Users can change operating conditions during normal CITS
operation via the Utilities menu.
Config

Use the Config command to change System Configuration
options (see SYSTEM CONFIGURATION for more details).
Import

Use the Import command to open CITS test files produced using
earlier versions of the product.
Diagnostics

The Diagnostics command allows users to verify the calibration
of the CITS and to re-calibrate the instrument

 The Help menu
 The Help menu includes concise explanations and instructions for
every CITS operation — press the F1 function key to access the
on-line help from anywhere in the program.

 Select Help Topics for help in operating the CITS500s.

 Select About for system information (firmware versions, etc.)
 If a modem is installed in the host computer and an Internet
connection is available, select Visit www.polarinstruments.com
to access the Polar Instruments web site for product and
application information.
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 4-3 The CITS main tool bar
 The CITS main toolbar contains buttons that provide quick mouse
access to some of the most frequently used CITS commands:
 

 
 

 Press the File New button to create a new test file.
 

 File Open... — press this button to display the Select Test
File dialog box and choose a test file. Each test file contains one
or more tests for the board under test.

 File Save — save the current test file.
 

 Board Edit — starts the Test File Editor
 

 Execute Test — perform a test using the selected test file.
 

 Print waveform — send current waveform to printer for
hard copy.
 

 Datalog Report Generator — start the (optional) Datalog
Report Generator.
 

 Clear Screen — clears the waveform display window.
 

 Visit Polar Website — Access the Polar Instruments
Internet Web site for updates and application information.
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 4-4 The Waveform Display window pane
 When a test is executed the CITS displays the resulting
impedance waveform along with the test limits (the hatched area),
and the results of the test in the Waveform Display window pane.

 

Fig 4-2  Waveform Display window pane

 The PASS/FAIL result and the statistical data for the tested region
of the displayed waveform (i.e. between the two hatched areas) is
included in the statistics/results area — the upper left corner of the
Waveform Display window pane. The tested region is commonly
referred to as the undisturbed interval (or flattest portion) of the
waveform and delimited by the width of the test limits (the
crosshatched areas — shown in blue by default).
 On completion of a test the resulting test waveform is displayed, a
PASS or FAIL is reported and displayed statistical data is updated.
 For single ended measurements four values are displayed:

•  Average impedance

•  Standard deviation

•  Minimum impedance

•  Maximum impedance
When differential impedance measurements are specified in the
test (i.e. when testing a differential pair of traces) two additional
values are displayed:

•  Odd mode impedance

•  Even mode impedance
Note: If the test limits are correctly set the average impedance is
the measured characteristic impedance for the trace under test.
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The Waveform Display shortcut menu
Right-clicking into the Waveform Display window pane displays
the Waveform Display shortcut menu:

The shortcut menu contains the most commonly used functions
for waveform display.

Vertical and horizontal axes
The vertical axis is graduated in Ohms/div by default. The vertical
deflection factors (Ohms/div) for each test are derived from the
settings in the test file (see Section 5 — EDITING TEST FILES).
The deflection factor can be changed on screen by right-clicking
the mouse on the vertical scale and selecting a new deflection
factor from the short cut menu:

The vertical axis can be graduated in mRho. Select Display in
mRho from the shortcut or the View menu. The CITS converts the
current Ohms/div setting to mRho.
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The horizontal axis is graduated in units of distance or time. When
measuring distance (i.e. along the controlled impedance trace) the
units of measurement can be selected by right clicking the
horizontal scale:

Horizontal units are graduated in inches, feet, millimetres, metres,
nanoseconds or picoseconds.
Changing the vertical and horizontal deflection factors via the
shortcut menus method will not invalidate the results of a test.

Group testing
Individual trace tests may be designated as members of a named
group and tested for impedance spread across the group.

From the Board menu choose the Edit Groups… command —
the Group Test Management dialog is displayed.

 

Enter a group name and maximum impedance spread for each
group for each group; up to five groups may be specified. Use the
Test List Editor to designate a test as a member of a group; see
EDITING TEST FILES.
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4-5 The Test List
The Test List is displayed in the Test List window pane.
The List contains one or more columns, or fields, displaying
information (for example, the description, test parameters or test
results, if any) for each test in the active test file. Descriptive and
parameter information is derived from the entries and settings in
the Test Setup Editor window. By default the Description (i.e. the
test name) and the Average impedance result are displayed.
Test results include a PASS/FAIL result along with statistical
information for the test. The Description field displays the PASS
result (green tick) or FAIL (red cross) for both absolute and group
spread values as shown in the table below

Pass/Fail
Indication

Impedance
Value

Group Spread
Test

✔✔ PASS PASS
✔✘ PASS FAIL
✘ ✔ FAIL PASS
✘ ✘ FAIL FAIL

Adding columns to the Test List
To add fields to the Test List right click into the Test List window
pane — the Test List short cut menu is displayed:

Choose the Select Columns command to display the Select Test
List Display Columns dialog box.

The Select Test List Display Columns dialog box comprises two
list boxes — the box on the left lists the fields which are still
available for inclusion in the Test List pane, the box on the right
lists the currently displayed fields
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Fig 4-3 Adding and removing fields with the Select Testlist Display
Columns dialog box

To add a column, select the field from the list of available fields
and click the Add button; to remove a column, select the field from
the list of displayed fields and click the Remove button.
To select a group of adjacent fields drag the mouse over the
range of fields; to select non-adjacent fields, hold the Ctrl key
down while clicking on the fields of interest — press OK to confirm
the selection.
Pressing the Reset button restores the displayed fields to the
default Description and Average fields.

4-6 The Datalog
Test results are recorded in the Datalog window pane.

With a test file loaded, as the first test is executed the test list is
added to the Datalog window. As each test is executed its results
are displayed in columns in the Datalog.
By default the Description, Layer, Average, Date and Time
columns are selected for display.
To display other result fields right click into the Datalog window
pane and choose Select Columns — the Select Datalog Display
Columns window is displayed:
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Fig 4-4  Adding and removing fields with the Select Datalog Display
Columns dialog box

Click on the field of interest in the list of available fields and press
Add to include a new column to the Datalog window pane.
If logging is turned off, each time a test is repeated the test results
overwrite previous data. A yellow circle alongside each test result
signifies that the results have not been logged. Datalogging is
discussed in Section 4-9 – LOGGING TEST DATA

4-7 The Status bar
The CITS status bar displays activity and status information and
messages to assist the user during CITS operation.

Figure 4-5  The CITS status bar

The status bar comprises three sections:
Current activity — the CITS reports its current activity, Ready...
(awaiting instructions), Calibrating..., Setting up..., Testing..., etc.
When the mouse is moved over a Toolbar button this portion of
the Status Bar is used to display a brief description of the button
function.
Calibration mode — indicates progress of testing and the currently
selected Calibration mode (Autocal — timed calibration or Cal on
Test — calibration before each test is executed).
Datalogging information — the number of logged items, updated
as each batch of tests is completed for a board.

4-8 Testing printed circuit boards
The procedure for testing printed circuit boards is similar to that
described for the sample test coupon in the previous section:

Select a test file if one exists (or create a new file and
insert tests for each controlled impedance on the
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board. Each test will include a complete set of test
parameters for the trace under test — see Section 5 —
Editing Test Files).

Select the test to be executed (usually the first test in the
list).

Connect the tip of the Microstrip probe to the board
terminals or connections (be careful to maintain correct
polarity of signal and ground connections).

Execute the tests via the Board menu or click the Test
button (see note below).

If datalogging has been turned on, when all tests for the
board are completed supply board details for data
logging in the Datalog Board Information dialog box.

Note: For convenience, users are recommended to use the Foot
Switch to operate the CITS in a “hands-free” mode. Using the Foot
Switch allows the operator to use both hands to hold the probe in
contact with, and support, the board under test).

Selecting a test file
Prior to testing a board or batch of boards a test file containing
tests associated with the board type must be selected (or created
if none exists). See Section 5 — Test Setup Editor for details of
creating, modifying and saving test files.

Select the File menu and the Open... command — the CITS
displays the Open dialog:

Figure 4-6  Selecting a test file

The Open dialog opens with the list of files (identified by the .cif
extension) in the current folder displayed. (Test files may also be
selected from the recently used file list from the File menu.)
If necessary navigate to the folder containing the test file. Select
the board test file by clicking the file name with the mouse (or
press the <Tab> key to move into the file list field and use the
cursor keys to highlight the test file) — in this case we test the
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single-ended coupon with the Coupon Test file — press OK to
load the file, then click on the 100 Ohm test.
The CITS displays the name of the selected file in the Title Bar
and the 100 Ohm Test ’s impedance and distance scales and test
limits in the Waveform Display window pane.

From the Datalog menu click on Autolog to turn automatic data
logging on and select Auto Advance and choose After Test to
step through the tests automatically and log results to the log file.
Select the test to be run and run the test.

The Auto Advance function controls how tests in the test file are
sequenced. Autoloading is controlled using the options in the Auto
Advance sub-menu — Off, On Pass, After Test. If Auto
Advance is turned Off the CITS will not automatically sequence
through the tests. Steps in the sequence must be manually
selected then run. If Auto Advance is set to After Test the CITS
will automatically sequence through the tests, regardless of test
PASS/FAIL results. When Auto Advance is set to On Pass the
next test file in the sequence is automatically loaded if the test
records a PASS.
To advance to the next test in the list manually, use the mouse or
the arrow keys on the keyboard.

Executing the Test
Most board testing will be performed with Microstrip probes. Using
Microstrip probes will minimise measurement errors due to
mismatch between the impedance of the measurement system
(50Ω) and the track under test.
Keep to a minimum the number of changes in impedance between
the CITS and the PCB track. The CITS output impedance is rated
at 50Ω so as far as possible use cabling and connectors from the
CITS with 50Ω characteristic impedance.
For more information and hints on testing PCBs and test coupons
see the notes at the end of this section.

Locate the Microstrip Probe in position (on the 100Ω impedance)
on the circuit board under test (the coupon). Connect the signal
pin to the signal trace pad and the ground pin to the ground plane
(reference plane) pad.
Hint: On test coupons the signal and ground pads can be
identified by shape (signal pins pads are commonly round in
shape, ground pins square).

Select the Test function from the Board menu (or click the mouse
on the Test button or use the Foot Switch for hands-off operation).
When the test screen is displayed the limits of tolerance defined in
the test for the tested portion of the track will be indicated by the
cross-hatched areas (at installation the CITS test window is set to
its default — blue cross-hatched areas on a black background —
see the Utilities menu for information on changing screen colors).
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During a board test the system checks that the displayed
impedance waveform falls within the limits defined in the test file.

Select the 100 Ohm Test and test the 100Ω impedance trace; the
results are displayed on screen and added to the log and the CITS
selects the next test in the list. Test each of the traces on the coupon.
As each group of tests is completed (e.g. when the whole board
has been tested) the Board Information box is displayed so that
board information may added to the test results and logged.
Data in the log may be processed by the optional Datalog Report
Generator.

Deleting test results
Select the Clear Results command to clear all test data from the
current set of results.

Caution: Selecting Clear Results will clear all result entries in the
Test List window pane but will not remove logged data.
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4-9 Logging Test Data
The Datalog function allows the operator to test and record the
results of a series of tests on a board or batch of boards. The
CITS creates a log file (a text file containing test data) for
archiving and subsequent analysis. The log file is stored in
delimited form (using the | character as the delimiter between
fields). This format will be found suitable for import into most
spreadsheet or database programs — and can be printed out for
hard copy. Polar Instruments supply a Datalog Report Generator
accessory to automatically process this data for use in statistical
process control. To enable logging select the Datalog menu and
ensure Autolog is turned on.
Test the board using the associated test file; when the test is
complete, the Datalog - Board Information dialog box is
displayed — Figure 4-7. (For details of creating user-defined fields,
e.g. Batch, Process, etc., see SYSTEM CONFIGURATION.) Enter
the details for the board under test — serial number, date code
and operator name and press OK.

Figure 4-7  Datalog information dialog box
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The Data Log window
The Data Log window displays all logged entries in the log file.
Test results are stored sequentially as records in the log file. If
necessary, use the scroll bar to scroll through the list when inspecting
records in the log. Each entry comprises a subset of the logged data
— board details, test name, trace layer, the result of each test,
average impedance and test date and time are included by default.
Columns for Maximum impedance, Minimum impedance and
Standard Deviation have been added to the Datalog window pane.

Figure 4-8 Datalog window pane with logged data

To include other information such statistical data, test parameters
right click into the Datalog window pane and choose Select Columns

Figure 4-9 Select Datalog display columns window

Choose the fields containing the statistical data or test parameters
and click Add then OK — the new fields will be added to the log
window.

Deleting records
To delete a single record from the log file, scroll through the list of
entries, select the record with the mouse or the keyboard cursor
keys and press the Delete button — all the tests for the board will
be deleted.
Note: The record will be permanently deleted.
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Editing records
Each line of logged data (a small yellow circle is shown against
data not yet logged) can be edited if necessary (e.g. to correct for
the results of spurious readings, intermittent connections, etc.)
with the Edit Line command. The Edit Line command is “greyed
out” for data not yet logged.

Right click onto the line to be modified and choose Edit Line to
display the Edit Datalog Line dialog box.

Figure 4-10  Edit Datalog Line dialog box

The Datalog field box lists the columns (fields) displayed in the
Datalog window.

Choose the Field to be edited
Select a value from the New Value list or type a new value
in the New Value box to replace the entry in the Old Value
text box.
Press OK to confirm the new value.

Printing logged data
To print the complete datalog right click into the Datalog window
pane and choose the Print command from the short cut menu. To
print only selected lines use the left mouse button + Shift or
Control to select the lines required.

4-10 Using Delta Time Cursors
Propagation delay times may be measured by positioning the
cursors at the beginning and end of the test specimen.

To enable the cursors select Cursors from the View menu or
from the Waveform Display short cut menu.
To position a cursor click the left mouse button on the cursor (the
mouse pointer changes to a double headed arrow); drag the
cursor onto the required location on the waveform. Release the
mouse button.
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The screen displays the distance and impedance where each
cursor crosses the impedance waveform.

4-11 Printing waveforms, datalog or test results
Select the Print function from the File menu.
The Print dialog box includes the Select Printout group of options
— choose Waveform, Datalog or Test List for printout. Use the
text box to add comments to the printout. See Figure 4-10.

Figure 4-11  Print dialog box

Select OK to proceed with printing.

4-12 Saving and viewing waveforms
The Save Waveform function allows the operator to store
individual test waveforms on disk. Test waveforms are stored as
files with the .cvf file extension. With the waveform displayed in
the Waveform Display window pane select Save Waveform from
the Waveform menu —the system will display the Enter
Waveform Filename dialog box.
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Figure 4-12  Save waveform dialog box

Choose a name for the waveform and press Open — the CITS
displays a Notes text box; add comments (board serial number,
date code, the operator’s name, etc.) and press OK.
To overwrite a previously stored waveform select the name of an
existing waveform file from the list and press OK.

Viewing recorded waveforms
Waveforms stored on disk with the Save Waveform function may
be retrieved and printed with the View Stored Waveform menu
command.

Select View Stored Waveform from the Waveform menu — a list
of previously recorded waveforms is displayed. Use the cursor
keys or the mouse to highlight and select a file from the list and
press OK. The CITS displays the stored waveform and associated
statistics with the CitsView program.

Further waveforms may be inspected using Open on the File
menu and results may be printed out using the Print command as
described earlier. To return to normal operation select Exit from
the File Menu.

The CitsView waveform viewer
The CitsView program allows the user to display waveforms saved
with the Save Waveform command. CitsView can display and
print saved waveforms and comments and the test parameters
specified for each saved waveform. Using CitsView the Waveform
Display can be maximised to full screen.
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Figure 4-13  CitsView waveform viewer

The items displayed in the Waveform Display window pane can be
controlled via the View menu (or the Waveform Display short cut
menu)

Select items for display as necessary.
Select the View Notes command to display the board comments,
etc.
To view the test parameters for the displayed waveform select
Setup — the Test Setup Editor is opened (for display only) with
the current test parameters.
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The Stored Waveform tool bar
The CitsView Toolbar includes buttons for the most commonly
used functions.

Press the Open button to view other stored waveforms.

Press the Print button to print out the displayed waveform.

 Visit Polar Website — Access the Polar Instruments
Internet Web site for updates and application information.

The Stored Waveform Status bar
The Stored Waveform Status Bar is similar in function to the
CITS500s Status Bar. Brief functional descriptions of each
command or button are displayed in the left of the Status Bar as
the mouse is paused over an item. The right of the Status Bar
displays the state of the Caps Lock, Num Lock and Scroll Lock
keys.

4-13 Reference Waveforms
The CITS incorporates the facility to store a reference waveform
as part of the definition for a test — the reference waveform is
displayed, e.g. as an example of a good trace, when the test is
selected. Reference waveforms can saved for each test in a file.

Setting a Reference Waveform
With a good waveform displayed, to save the current waveform as
the reference waveform for a test use the Save Reference
command from the Waveform menu. The waveform is then
displayed whenever the test is selected. To make this change
permanent save the test file and reference to disk using the Save
command from the File menu.

Viewing a Reference Waveform
To view the current reference waveforms for the tests use the
View References command from the Waveform menu.
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4-14 Overlaying waveforms
The Overlay command from the Waveforms menu allows
waveforms from a series of test operations to be superimposed, or
overlaid.

The Overlay option displays a sub-menu from which the user
specifies the number of waveforms to be superimposed — 2, 5,
10, 20 or 50.

With the Overlay option selected, the waveform window is not
cleared between board tests. The results of the last 2, 5, 10, 20 or
50 tests will appear superimposed until Overlay is deselected (set
to Off) — when the maximum number of overlays is reached the
oldest test result will be discarded first. See Figure 4-13.

Figure 4-14  Waveforms superimposed in Overlay mode

Test the board or batch of boards as described earlier — the test
waveforms from each test operation will be overlaid on the
previous waveforms until Overlay is switched off.
Note: the PASS/FAIL result and information appearing in the
Statistics area ONLY refer to the most recent test. The Statistics
area does not accumulate data.

Turn Overlay off the to clear the overlaid waveforms.
Note that the last test result is not cleared — if necessary use
Clear Results to clear the screen.
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4-15 Exiting the CITS program
Select Exit from the File menu to leave the CITS program.

4-16 Notes on testing printed circuit boards
Board testing should normally be carried out using the Polar
Instruments Microstrip probes. These probes are designed to
minimise measurement errors caused by mismatch between the
impedance of the measurement system (50Ω) and the PCB under
test.
Operation is possible however using direct connections to a board.
Note the following observations when not using the Microstrip
probes.

Keep impedance changes to a minimum
When setting up PCBs for test, the most accurate results will be
achieved by keeping to a minimum the number of changes in
impedance between the CITS and the PCB track.

The CITS output impedance is rated at 50Ω so as far as possible
use cabling and connectors from the CITS to the PCB track with
50Ω characteristic impedance.
Use a probe which minimises the impedance discontinuity at the
interface to the PCB.

Use high quality cabling.
Always use high quality low loss cable. Low quality cable may
show series resistance, dielectric losses and radiated losses.
Series resistance will be displayed as a gradual increase in
characteristic impedance along the cable.
Inexpensive cables also tend to have greater impedance
variations over their length and at the connectors at each end.

 Precision cables (50Ω ±1Ω) are provided with the CITS.  Note: the
CITS is calibrated before shipment using the cable labelled with
the instrument serial number.   Use this cable on the MAIN input
for optimum system accuracy.
 When replacing instrument cables it is important to check (and
adjust if necessary) the CITS’ Cable Length calibration and
impedance measurement accuracy.
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Compensate for unavoidable impedance changes
When testing 75Ω tracks using 50Ω cabling the level of ringing
and aberrations in the leading edge of the plot is noticeably worse
than for a 50Ω track. This is because of the step in impedance at
the probe to PCB interface.
This can be compensated for in two ways:

Measure impedance only over the relatively flat portion of
the plot. Use the Test Setup Editor to set the Test from
and Test to parameters to avoid ringing and aberrations in
the leading edge of the TDR trace.

Use a 75Ω Microstrip probe so that aberrations occur at
the 50Ω cable to probe interface and there is a smooth
transition at the probe tip to PCB interface.

A Coupon Holder (ACC153) is available to support coupons during
testing.
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SECTION 5 — EDITING TEST FILES

TEST PARAMETER FILES

EDITING TEST FILES
Each board type to be tested is tested in accordance with one or
more tests each of which includes a set of test parameters.
Typically the set of tests for one board type will be stored in a
single test file. For example, the coupon test files contained the
tests for the sample coupons supplied with the CITS500s. The
diagram below illustrates the test parameters specified in a test.

Figure 5-1 Test parameters defined in a test

In Figure 5-1 letters P, A, B, T signify the test parameters listed
below:

P = Probe Length
A = Test From
B = Test To
T = Tested region (B – A)
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5-1 The Test Setup Editor
Test parameters for boards under test may be defined or modified
using the integrated Test Setup Editor. See Figure 5-1.

Figure 5-2 The Test Setup Editor

5-2 Creating and modifying test files

Creating a new test file
To create a new test file choose the New command from the File
menu. This will create a new test file called Untitled and display
the Edit Board Details dialog box. This dialog will be displayed
each time a new batch of tests (i.e. a new board type) is created.
Enter the details for the board under test, Customer, Board Type,
Part Number and Revision Number and Press OK.
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Figure 5-3  Edit Board Details dialog box

The CITS500s creates the new (empty) file. Tests are added to
the file via the Insert command.

Inserting tests
Select the Insert command from the Board menu (or press the
Insert key) — the Test Setup Editor is displayed:
Each parameter is defined and displayed in a parameter field. To
create or edit a test, modify the test parameters as required and
then use the OK button to confirm the field edits.
The fields are described in the following sections.

5-3 Board test parameters
Entries in the fields contained in the Test Setup Editor will be
available for display in the Test List and Datalog and printed out
with the test results.

Description
Enter the test type into the Description field (e.g. D-1, 50 Ohm
Trace, etc). The Description is included as part of the data for a
board.

Layer
Use the Layer field to indicate the trace layer (e.g. L1).
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Impedance
Use the Impedance field to define the nominal impedance in
ohms of the PCB track under test.
This field must contain a number of up to 4 significant digits in the
range 10.10 – 200 Ohms.

Probe Channel Select
Use the Probe Channel Select function to specify the CITS
channel or channels to be used for the test.

Specify any of the four channels for single-ended tests. For
differential tests use Channels 1 and 2 or Channels 3 and 4.

Single-Ended Test
To perform a single-ended test click the Single-Ended Test
option button and click the channel number check box.
 The CITS is calibrated before shipment using cables labelled with
the channel number and instrument serial number. For single-
ended testing, connect a probe cable to its corresponding CITS
channel and connect the Microstrip probe to the probe cable.
Note: To preserve signal integrity, it is strongly recommended that
the cables supplied with the instrument and labelled with the
instrument serial number and channel number be used.

Differential Test
To perform a differential test, click the Differential Test check
box. Selecting Differential Test will add Odd and Even mode
impedance statistics to the statistical data.
In order to perform differential measurements the CITS500s uses
Channels 1 and 2 and Channels 3 and 4 as differential channels.
Differential testing is performed using the IPD100 Differential
Probe. For differential testing, connect the differential probe to
Channels 1 and 2 or Channels 3 and 4 using the supplied cables.
 Click the check boxes to specify the CITS channel pair.
Note: It is critical for a differential test that the probe cabling for
both channels is of matched impedance and length.
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Horizontal Units
The horizontal axis on the Waveform Display screen can display
either distance along the trace under test or “real (i.e. out and
back) time”. Click on the drop down list box arrow to display the
units available:

The Units field specifies the units (Feet, Inches, Millimeters,
Meters, Nano-Seconds and Pico-Seconds) which will be used for
the Test From, Test To and Probe Length fields. It defines the
units used to specify all the distance or time parameters and those
used on the horizontal axis of the displayed waveform.
Note: If time units are selected the Waveform Display window
displays “real time”, i.e. the “out and back” time for the TDR pulse.

Test from
This parameter, along with the Test to parameter enables the
user to specify the length of trace or propagation time to be
tested. This allows the user to avoid testing for controlled
impedance in an area where the displayed waveform may be
ringing (e.g. where a sharp change of impedance occurs in the
test system connection).

The Test from parameter specifies the distance or time from the
start of the display to the start of the length or time over which
impedance is to be tested (see Figure 5-1).
It defines the start of the tested area within the display window

Test from may be set in the range:
Distance
0 to 600 inches
0 to 50 feet
0 to 15.24 meters
0 to 15240mm.
Time
154.04nS
154040pS
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Test to
The Test to parameter specifies the distance or time from the
start of the display to the end of the length or time over which
impedance is to be tested (see Figure 5-1). It defines the end of
the tested area within the display window.

It is important to set Test From and Test To to define part of the
undisturbed interval in the display.
Typically this will correspond to a region as shown below.

50% 70%

Test to may be set in the range:
Distance
0 to 600 inches
0 to 50 feet
0 to 15.24 meters
0 to 15240mm.
Time
154.04nS
154040pS

Note that Test to must be greater than Test from.

Probe length
The Probe length field specifies the distance or time from the
CITS front panel connector to the beginning of the displayed
graph on the PC (see Figure 5-1).

If the supplied cable and a Microstrip probe are used Probe
Length can be left at its default value (45 inches, 11.55 nS).

If a different connection method is used Probe Length can be
used to define the starting point of the display (i.e. the left edge of
the screen) in terms of the distance or time from the CITS front
panel. For example, if 37 inches is specified the display will show
a graph of impedance starting 37 inches from the CITS front panel
connector.
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Probe length may be set in the range:
Distance
0 to 600 inches
0 to 50 feet
0 to 15.24 meters
0 to 15240mm.
Time
154.04nS
154040pS

Loss Compensation
The Loss Compensation field may be used to compensate for
series loss in the track being tested.
Any series resistance will appear as a ramp in the waveform with
impedance increasing linearly with distance. Series resistance
simply adds to the characteristic impedance over the length of the
waveform.
This phenomena is caused by the DC resistance of the track
combined with high frequency skin effects reducing the effective
cross-sectional area of the track.
Series loss can be compensated for by adjusting the slope of the
waveform by a specified number of ohms/horizontal unit. This
cancels out the series resistance leaving the true characteristic
impedance displayed.
Note: Series loss may be distinguished from the case of a slightly
tapered track by testing from both ends of the trace. In the case of
series loss the impedance waveform will appear to have the same
rising slope when tested from both ends.
For normal use it is suggested that loss compensation should be
left in the default state — disabled. In some instances, however,
where long conductors or those with small cross sectional area
are being tested enabling loss compensation may prove useful.

Select User to display the Series Loss text box then type in the
desired value.
See SPECIFICATIONS for the range of acceptable values.

Velocity of Propagation (Vp)
The Velocity of Propagation (Vp) is the speed at which electrical
signals propagate along a cable or printed circuit board trace. Vp
is given as a percentage of the speed of light, c.
The speed of the signal depends on the dielectric of the medium
in which it travels. For simplicity of operation the CITS program
assumes that all cables and PCB tracks have a velocity of
propagation of 66% the speed of light. The CITS calculates
displayed distance or time from time based on a default Vp of
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0.66. This value will be found valid for typical coaxial cables and
circuit board traces.
This will, however, result in some apparent errors in the indicated
distances and times in systems which have significantly different
velocities of propagation. For example, airlines, which have a very
high velocity of propagation (98–99% the speed of light), will
appear shorter than their true physical length if both are measured
with the default Vp. Since the purpose of the CITS is to measure
impedance, for most applications the linear accuracy of the
horizontal scales will probably not be critical.
If desired, the Vp used for display of test waveforms can be
adjusted for the display window. If Vp is correctly adjusted then
the displayed electrical length of any tested specimen will match
its physical length. This adjustment is applied to all of the
displayed waveform.

For most applications leave the Vp setting at Default.
Selecting the User option displays a text box containing the
current value of Vp. With the text box displayed use the left and
right arrow keys or the mouse to locate the cursor and type in the
desired value.

Ohms/div
The vertical axis on the PC screen is scaled in ohms per vertical
division. The scale may be set to one of the pre-defined values 1,
2, 5, 10, 20 or 50 ohms/div.
Click the dropdown list box arrow to select the vertical scale value.
Choose the scale factor which gives optimum display — lower
values display the waveform in greater detail.

Group Spread Test
The test may be designated as part of a test group defined by the
Board|Edit Groups… command.

To assign the test to a group click the Enable check box and
select the group from the Group Name combo box.
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Test Method
When this parameter is set to Absolute the CITS will record a
FAIL if the trace waveform is out of tolerance (i.e. touches the
crosshatch area of the test limits) at any point over the tested
area.

Selecting Average will cause the test to fail only if the average
impedance value (top left of screen statistics box) is out of
tolerance.

When Average is selected the test limits (50Ω nominal
impedance, ±10% between 2 inches and 8 inches) are displayed
as shown in the diagram below:

Figure 5-5 Average Test Method display window

This method is used most often when large numbers of via holes
are disturbing the PCB trace impedance waveform. Typical
examples are backplane traces.

Tolerance
This parameter defines the tolerance about the nominal
impedance to which the track will be tested.
Plus and Minus tolerances may be locked; i.e. have the same
value, or unlocked, where each value is set independently. Click
the check box to lock or unlock the tolerance.
The tolerance must be set to a value in the range 0.10% to
99.99% in 0.01% steps. Alternatively it may be set directly in Ohms.

Press OK to confirm the test parameters and close the Test Setup
Editor.
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5-4 Saving the test file
  Press the Save button to

save the file
When all tests for the board under test have been specified press
the Save button, or use the Save or Save As commands from the
File menu, to store the file as a new test file. The system will
display the Save As dialog box to request the new file name.

Naming test files
Names assigned to test files must conform to the Windows 95/NT
conventions for file names. File names must be unique and may
contain up to 255 characters. The following characters may be
used in file names:

Letters A to Z and a to z

Numbers 0 to 9

and the following special characters:

- ! $ % ^ & ( ) @ ~ # { } ` ' _

Operating system reserved characters such as backslashes ( \ ),
question marks ( ? ) and asterisks ( * ) and are not permitted in file
names. For more information on file naming conventions, consult
the Windows 95/NT operating system user guides.
It is recommended that users employ systematic test naming
schemes in which tests are assigned descriptive names

Saving test files under new names
To save a file under a new name select the existing file using the
Open command from the File menu, choose the Save As
command and name the new file (if necessary edit the file).

5-5 Using existing files as templates
An alternative method of creating a new test file is to open an
existing test file, save it under a new name and then edit it. If this
is a new test file, select a suitable existing file and edit the
parameters for each test as required.

5-6 Printing test files
To obtain hard copy of test files (e.g. for reference or customer
conformance reports) right click the Test File window pane (or
select the Print command from the File menu (or press Ctrl-P).
The Print function will print to the default Windows printer.
Click the Print Preview command to inspect the printout prior to
printing.
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SECTION 6 — MAINTENANCE AND FAULT FINDING

MAINTENANCE AND FAULT FINDING

Cable Replacement
Whenever cables are replaced on a system the user should use
the Calibration function to calibrate the CITS/cable system.

CITS Verification and Calibration
The CITS500s includes facilities to verify the accuracy of the
CITS500s system (i.e. the instrument and probe cable without the
probe) and if necessary calibrate the system against impedance
standards (e.g. airlines or similar).
If the CITS is to be used for measurements of low impedances
(e.g. 28Ω) it is recommended that the system accuracy is verified
daily.
Note: It is important to ensure that when the system is verified or
calibrated the probe cable attached is the cable used for testing
boards.

Verification
•  Select the Diagnostics command from the Utilities menu

•  Connect the working probe cable, without the probe, to
the MAIN SMA front panel connector.

•  Press the Learn Cable Length button. The CITS will
determine the length of the cable, and display the time
difference from the nominal length. If necessary press
Apply Correction to adjust the system calibration.

•  Choose the impedance to be verified and connect a
suitable impedance reference to the probe cable.
Verifying differential accuracy will require a pair of
references.  See section on Differential Calibration.

•  Press the associated impedance button and enter its
exact impedance.

•  Note the error in the CITS500s reading.

•  Repeat for the other impedances.

•  If necessary perform the Calibration described in the next
section.

•  Press OK to exit.
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Calibration
Caution: Incorrect use of Calibration mode may invalidate the
CITS500s calibration
Calibration should only be carried out against NIST/NPL traceable
impedance standards (e.g. airlines or similar).

•  Select the Diagnostics command from the Utilities menu

•  Double click the right mouse button on the CITS500s icon
to enable Calibration mode.

•  Press the Learn Cable Length button. The CITS will
determine the length of the cable, and display the time
difference from the nominal length. If necessary press
Apply Correction to adjust the system calibration.

•  Connect the probe cable to the reference impedance.
Calibrating differential accuracy will require a pair of
references. See section on Differential Calibration.

•  Choose the impedance to be calibrated and press the
associated button. If necessary press Apply Correction to
adjust the system calibration.

•  Repeat as necessary for other calibration points.

•  Press OK to exit.

Differential Calibration
Differential calibration or verification will require a pair of reference
impedances. Calibration at 100Ω (differential) will require a pair of
50Ω airlines, 150Ω (differential) will require a pair of 75Ω airlines
etc.

Impedance References for Calibration
Calibration should only be carried out using references that have
been made traceable to NIST/NPL.
The reference impedances used to verify or calibrate may be
either airlines or measured semi-rigid cables.
A Verification Kit is available (Polar Instruments part number
ACC229) containing a range of semi-rigid cables which have been
measured against traceable standards, making them suitable for
verification and calibration of the CITS.
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CITS500s Servicing

WARNING This instrument should only be serviced by a qualified
electronics technician.

IMPORTANT The CITS is an extremely sensitive measuring instrument. To
prevent damage to the CITS observe static precautions at all times. See
Appendix B for information

Refer all servicing to qualified service personnel. Polar
Instruments publishes a CITS Service Manual to assist the service
technician.

Microstrip probes
If a different pitch between the ground and signal pins on the
Microstrip probes is required this may be adjusted with the aid of a
soldering iron. (In the event of damage or loss to the spring loaded
pins, replacements are obtainable from I.D.I or their local agents.
The order code is SS 75E 4.9 G)

Cleaning
Clean the CITS500s with a cloth lightly moistened with water with
a small amount of mild detergent. Alternatively, a cloth lightly
moistened with alcohol (ethanol or methylated spirit) or isopropyl
alcohol (IPA) may be used.
Do not spray cleaners directly onto the instrument.

Technical Support
For technical support contact your local Polar Instruments
distributor or Polar Instruments. See front cover for email address
and fax numbers.

Consumable parts
Cables and probes should be replaced every two years or when
showing signs of significant wear.
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Fault diagnosis
The following symptoms may be investigated by the user. More
serious faults should be referred to qualified personnel.

Symptom Test

Communication Error
reported by the host
computer

Check CITS power is switched on.
Check CITS green BUSY LED is lit for a few seconds on power
up then extinguished. If the green LED stays lit, the CITS is
faulty; refer to the supplier or agent
Check the connection of CITS to the PC.
Check that the cable used is the cable supplied with the CITS.
Check that the COM port connected to the CITS matches that
selected via the System Configuration screen.
Check for no Communication port conflicts

Foot switch not working Check that the RS232 cable in use is the cable supplied.
Ensure that if a 9–25 way RS232 adaptor is used all 9 signal
lines are connected.
Check that the Foot switch is plugged in.

Printer fails to work Check the printer is switched on.
Check connection of the PC to the printer.
Print a window test page for the printer.
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APPENDIX A

CHARACTERISTIC IMPEDANCE

CHARACTERISTIC IMPEDANCE OF CONDUCTORS
The characteristic impedance of a conductor is a function of the
dimensions of the conductor, its surrounding environment and the
dielectric constant Er of the insulating material.

The diagram below includes equations for calculating the
characteristic impedance of coaxial cable, microstrip and stripline.
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Figure A-1 Typical conductors and associated impedance equations

Figure A-2 Reflection magnitude v discontinuity impedance for a 50Ω Zo, step output TDR

Determination of characteristic impedance
The CITS displays a graph of the characteristic impedance of a
specified length of PCB trace. This is achieved by calculating the
impedance along the length of the cable or PCB based on the size
of the reflections measured using time domain reflectometry.
The above graph shows the size of reflection from an impedance
discontinuity encountered by the out-going pulse of a 50Ω, step
output TDR such as the CITS.
The CITS software translates the magnitude of voltage reflections
measured by the TDR into a linear plot of impedance against
distance. Note that the size of the reflection is not linearly related
to the impedance discontinuity. As the impedance gets larger the
slope of the curve is reduced so that at high impedances a large
change in impedance will only cause a small change in reflection.
Consequently the accuracy of measurements of high impedances
is reduced.
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APPENDIX B

ELECTROSTATIC DISCHARGE

PROTECTING THE CITS FROM ELECTROSTATIC DISCHARGE

Caution: The probe/input circuitry of the CITS includes sensitive
components that are susceptible to damage from electrostatic discharge —
precautions must be taken to avoid static discharge into the probe.

Many of the components in modern instruments like the CITS
employ internal construction which may be damaged by
electrostatic discharge (ESD). Such components are often
referred to as static sensitive.
Damage caused by electrostatic discharge may be severe enough
to result in the complete and instant failure of a component. Often,
however, components are not destroyed but merely degraded and
failure occurs in later use.
Some devices are sensitive enough to be damaged or degraded
by electrostatic discharge of only several tens of volts, voltages
not uncommon at a typical unprotected work station.
Everyday activities such as applying tape from a dispenser,
walking across nylon carpets or separating plastic transparency
films can generate charges of several thousand volts.

Sources of static electricity
There are two sources of static electricity most likely to be
encountered by the technician:
People (especially when wearing clothes made from synthetic
fibre)
Packaging materials such polythene (e.g. bags or tubes),
polystyrene containers or padding (e.g. chipples, etc.) and
adhesive tape used to seal containers

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



B-2  ••••   MAINTENANCE AND FAULT FINDING  CITS500s

Static free workstations
Static sensitive components, including completed circuit boards,
should only be used (i.e. inserted or replaced) at a static free work
station. The static free work station will typically include anti-static
bench mats, floor mats and wrist straps and should be kept free
from materials which could generate or store a static charge.

Working with the CITS
When using the CITS observe the same procedures as when
handling static sensitive components:
Use the CITS at an approved anti-static work station.
Wear a wrist strap connected to a suitable earth point. A wrist
strap is provided with the CITS (connect the wrist strap to the stud
on the CITS front panel).
Other protective clothing, such as conducting heel straps and
metallised coats can be worn if available.
Keep materials which may produce static electricity away from the
work station.
Treated completed circuit boards as static sensitive components.
Avoid dragging the CITS probes across work surfaces.
Do not point the probe tip at surfaces that may have a static
charge, e.g. monitor screens
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APPENDIX C

STATUS OUTPUT CONNECTOR DETAILS

Pin Name Description (all outputs are open-collector)
1 Pass On if test passes
2 /Pass Off if test passes
3 Fail On if test fails
4 /Fail Off if test fails
5 Testing On during testing
6 /Testing Off during testing
7 Strobe Turns On to strobe Pass and Fail outputs
8 /Strobe Turns Off to strobe Pass and Fail outputs
9 Common Common line for all outputs
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APPENDIX D

APPLICATION NOTES

Controlled Impedance Application Notes currently available
Polar Instruments produces a series of Applications Notes to assist
customers with Controlled Impedance testing applications.
The following Controlled Impedance Application Notes are currently
available.

AP118 Frequently Asked Questions on Controlled Impedance
AP131 Paper – Calculation of PCB track impedance
AP120 Introduction to Controlled Impedance
AP130 Sources of impedance measurement error
AP127 Measuring short traces
AP121 Transmission Line Configurations
AP122 Microstrip Transmission Line Structures
AP123 Single-ended Stripline Structures
AP124 Testing with Test Coupons
AP125 Calculating differential and coplanar impedance on FR4
AP125A Paper – Calculating differential impedance on FR4
AP117 CITS25 De-activation Procedure
AP104 Test Procedure for Rambus®
AP128 Choosing the best probe for your application
AP129 Characterising your process

Application Notes are added on a frequent basis; contact your Polar
representative or check the Polar Instruments web site
www.polarinstruments.com for the latest notes.
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Experienced engineers and technicians on staff 
at our full-service, in-house repair center
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www.artisantg.com/WeBuyEquipment

                        REMOTE INSPECTION
Remotely inspect equipment before purchasing with 
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specifications, manuals, and documentation
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